
Utility FM+EN
User guide

Overview of version 3.0

EndNote is a widely used tool for creating bibliogra-
phies. This product does however, not support 
FrameMaker. The utility FM+EN bridges this gap by:

Inserting temporary citations with CTRL+y

Replacing temporary citations by formatted cita-
tions in FM documents and FM books.

Temporary citations may be expanded to biblio-
graphic references. Most likely these are in foot-
notes.

FM+EN controls the collaboration of the following 
programs:

FrameMaker (versions 6…8, de/en)

MS Word (versions2000…2003, de/en) 1)

EndNote (versions 8…11, en only).

1 Word 2007 has a completely different menu system and can 
not be handled.

Editors Note
Preliminary documentation:

Expansion of citations to references 
has not yet been tested.
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Bibliography with EndNote
EndNote (www.endnote.com) is one of the most used applica-
tions to maintain bibliographic data bases and generate bibli-
ographies in scientific works.

The product is widely used for dissertations, theses and sci-
entific publications of all kinds. EndNote is available for Win-
dows and Mac OS. It is well integrated with MS Word but not 
with FrameMaker.

Cooperation with FrameMaker

Advantages using 
EndNote

Although bibliographies can easily be created in FrameMaker 
by means of cross references, EndNote provides the following 
advantages:

Maintenance of a bibliographic database for several works.

The database can be filled with data from various sources 
including the Internet.

Generated references and citations can adhere to a large 
number of output formats (most publications require spe-
cial formatting).

Using EndNote’s RTF scan 
facility

It may seem reasonable to export the FrameMaker document 
as RTF, then scan and modify it by EndNote and finally import 
the RTF again into FrameMaker. However, some problems are:

Anchored frames get new attributes (at insertion) with all 
previous content as one image.

Layout and formats must be re-applied.

Cross references become useless, must be rebuilt.

Solution with 
D+DD utility

D+DD has developed the utility FM+EN which controls the 
collaboration between FrameMaker, Word and EndNote. A 
special paste command manipulates the temporary citation. 
For FM < 8 this implies code conversion (Unicode 8 FM).

An intermediate RTF file contains only the data concerning 
the bibliography and not the complete FM document.

Of course, nothing is perfect – FM+EN may not satisfy your 
demand. See Setting up the utility on page 11. 

Forms of citations 
handled

Any form of temporary citation (copied from EndNote) can be 
handled by the current version of FM+EN, for example, the 
following:

Characteristic Example

Simple form [[Müller, 1925 #13]]

With page range [[Neuman, 2003 #653, p. 53-54]]

Combined citations [[Shone, 1998 #222; Rogers, 2003 
#551; UNWTO, 2006 #608]]

Special symbols in author 
names

[[Wisconsin Dept. of Health & Family 
Services, 2004 #614]]
[[Barnes-Ellerbe, 2004 #290]]

http://www.endnote.com/
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Process overview

The utility FM+EN controls the data flow between the three 
involved programs:

Process details During the text development temporary citations are copied 
from EndNote and pasted into the FrameMaker document. 
However, not CTRL+v is used for pasting, but the new com-
mand CTRL+y provided by FM+EN. This command modifies 
the temporary references for this process.

Note: Save your document before starting FM+EN. You can not 
UnDo2) the replacement of the temporary citations performed 
in step 3. But since FM+EN does not save the processed file you 
may «revert to saved» for undoing all actions of FM+EN.

Step 1 The temporary citations are collected in FrameMaker and 
written into an MS Word file. Two forms are written to avoid 
problems during resolving the references in EndNote:

The bracketed form which is present in FrameMaker, for 
example [[Müller, 1925 #13]]

The form with braces for EndNote to resolve the reference, 
for example {Müller, 1925 #13}. This is called the EN-
form.

[[Müller, 1925 #13]] {Müller, 1925 #13}¶ 

Step 2 EndNote scans this Word file (in rtf = Rich Text Format) 
based on the current bibliographic database and the selected 
output format. The result is a new rtf file containing both the 
formatted citations and the generated bibliography.

Müller et al 
[[Müller, 1925 
#13]] developed 
an open issue 
on this and 
hence …

Bibliography

[[Müller, 1925 #13]] {Müller, 1925 #13}

[[Müller, 1925 #13]] {Müller, 1925 #13}

[[LaBonté, 1989 #11]] {LaBonté, 1989 #11}

[[Garneau, 1990 #12]] {Garneau, 1990 #12}

[[Bartels, 1981 #14]] {Bartels, 1981 #14}

[[xxx xxx xxx]] {xxx xxx xxx}

EndNoteBibliographic

database

FM with temporary citations

Müller et al [1] 
developed an 
open issue on 
this and hence 
…

Bibliography

[1] Müller, …

[2] Bartels, …

FM Bibliography resolvedWord

[[Müller, 1925 #13]] [1]
[[Müller, 1925 #13]] [1]
[[LaBontÃ©, 1989 #11]] [4]
[[Garneau, 1990 #12]] [6]
[[Bartels, 1981 #14]] [2]
[[xxx xxx xxx]] {#}

1. Müller, P.D.H., De 
viris illustribus. 9 ed. 
1925, Hannover: Carl Meyer 
(Gustav Prior). 155.

2. Bartels, K., Veni 
vidi vici. 5 ed. Lebendige 
Antike. 1981, Zürich: Artemis 
Verlag. 88.

Word

Output

formats

1 2 3

FM+ENtemporary citation

formatted citation

biblographic reference

2 Well, in FM 8 and above you have more than 1 Undo step, but some 100 
Undo’s might still be impossible.



1 - 5 FM+EN 3.0

Process overview
D

O
:\

[E
]\

_D
D

D
p

ro
je

ct
s\

FM
+

E
N

\D
o

cu
m

e
n

ta
ti

o
n

\f
m

+
e
n

-d
o

cu
.f

m
 

2
0

0
8

-0
9

-2
3

Step 3 The first part of the rtf file from step 3 now contains format-
ted citations to the right according to the output format 
selected in EndNote:

Numbered formats The right part now contains the formatted citations

The second part of the new file contains the generated bibli-
ography:

Author-Date formats Author-date formats do not contain a simple 1:1 relationship 
between the formatted citation and the bibliographic refer-
ence:

Further processing by
FM+EN

With this data the temporary citations in the FrameMaker file 
are searched and replaced by the formatted EN-form.

The user must copy the bibliography to an appropriate place 
in the FrameMaker document or book and format it.

Note: You must use Paste Special and select RTF to maintain the 
local character formatting from Word.

Note: The author recommends you to save the processed FM docu-
ments in a different directory (including the book file). This 
allows you to continue your textural work with files containing 
the temporary citations. This is also a safeguard against prob-
lems with the utility – which unfortunately can not be avoided 
completely.

[[Müller, 1925 #13]] [1]
[[Bartels, 1981 #14]] [2]
[[xxx xxx xxx]] {#}

1. Müller, P.D.H., De viris illustribus. 9 ed. 1925…
2. Bartels, K., Veni vidi vici. 5 ed. Lebendige…

[[Müller, 1925 #13]] (Müller 1925)
[[Bartels, 1981 #14]] (Bartels 1981)

Bartels, K. (1981). Veni vidi vici. Zürich, Artemis 
Verlag.

Müller, P. D. H. (1925). De viris illustribus. 
Hannover, Carl Meyer (Gustav Prior).
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Specialities and restrictions
Although FM+EN v3.0 handles citations in UTF-8 format, it 
does not handle files with UTF-8 file names (e.g. Пушкйн.fm)

EndNote output formats

1 FM+EN v3.0 can not work with EndNote output formats 
which replace the temporary citations with nothing. Some 
formats of this type are: Footnotes (EN 8), Amer Literature 
and GPA Verlag. Check your particular format for the prop-
erty Citations > Templates. This must not be empty. If it 
is empty, fill in [Bibliography Number].

2 Output formats with inline formatting. These are only han-
dled for references in footnotes. A citation currently can 
not receive special formatting such as superscripting.

Collecting temporary citations

Temporary citations are collected and expanded in these 
places:

Standard text flow

Footnotes

Table title, heading, cells (for table footnotes see Mixing 
citations in text and in footnotes on page 7; it may be 
resolved, if it can be resolved in the text elsewhere)

Cross references. The citation is not expanded by FM+EN, 
but by the update of the reference. 

Temporary citations are not found in the following places:

Text frames within anchored frames.

Text lines

Note: The reason for the latter two restrictions is the termination of 
the search loop by a stop code at the end of the text flow. Text-
frames and text lines in anchored frames are searched after 
the text flows and hence can not be found by the automatic 
process – although you can find them by a manually invoked 
search.

Author names with quotes

Although it is not typographically correct, you may use the 
following quote characters in names: 
Apostrophe (x27): D'Alembert; accent grave (x60): D`Alem-
bert; accent acute (xB4): D´Alembert. 
The correct character would be the single right quotation 
mark (x92): D’Alembert. Hawaiian names may contain a cor-
rect single left quote (x91): Kaho‘olawe. 

All of these forms are handled correctly by FM+EN.

Note: Be aware of the FM setting Smart quotes in Format > Docu-
ment > Text options. Do not type over the inserted apostrophes!
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Mixing citations in text and in footnotes

You may have citations in paragraph text and in other para-
graphs in footnotes which contain the citations. However, 
when mixing inline citations with citations in footnotes within 
one paragraph, two cases are to be distinguished:

Restrictions in FrameMaker < 8

FrameMaker until version 7.2 uses an internal code page, 
which is not even sufficient for all Western European lan-
guages, not to speak of Central European languages. EndNote 
on the other hand uses Unicode in its database since version 
8. Hence for FrameMaker 7 documents FM+EN must perform 
code conversions during the copy and paste processes.

It is easy to understand that the method used in FM+EN can 
not handle citations and references with none-latin scripts:

Even for the latin script the process can not handle characters 
outside of the character repertoire of FrameMaker, such as Z 
caron (Žž) or the character eng (Ŋŋ) used in Sami languages.

In the temporary citations only author names with characters 
built from the FM character set can be handled or displayed 
correctly. Therefore you can only use latin transliterated 
names in your bibliographic data base (Kirtakis or Pushkin for 
the above mentioned).

Some characters not 
recognised as such by 
FrameMaker

FrameMaker < 8 does not recognise the following characters 
as such in Find with Wildcard ? or *. In contrast, they are rec-
ognised as punctuation:

Ð (Latin Capital Letter Eth); ð (Latin Small Letter Eth); Þ (Latin 
Capital Letter Thorn); þ (Latin Small Letter Thorn); Š (Latin 
Capital Letter S With Caron); š (Latin Small Letter S With 
Caron); Ý (Latin Capital Letter Y With Acute); ý (Latin Small 
Letter Y With Acute.

This is not a problem for FM+EN v3.0, because citations are 
searched within the utility and not be means of FM functions.

Inline citations before 
footnote citations

Inline citations after 
footnote citations

In paragraphs where the inline cita-
tions are first [[World Health 
Organisation, 2003 #37]], the cita-
tions in footnotesa are not handled, 
because the footnote text is not vis-
ible in the copy/paste buffer.

a. [[Þornbjørn, 1793 #30]]

In this paragraph the first two cita-
tions are put into footnotes b and 
this onec and inline citation(s) fol-
low: [[Matějček, 2006 #27]]. This 
arrangement is treated correctly by 
FM+EN.

b. [[Barnes-Ellerbe, 2004 #48]]

c. [[O’Brien, 2005 #49]]

Citations in footnotes are not handled. Citations in footnotes are handled.

Inserted temporary citation What was intended

[[ÎšÎ¹ÏÏ„Î¬ÎºÎ¹Ï‚, #28]] [[Κιρτακις, #28]]
[[ÐŸÑƒÑˆÐºÐ¹Ð½, 1823 #29]] [[Пушкйн, 1823 #29]]
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Setting up EndNote
The FM+EN process assumes a certain setup of EndNote:

In EndNote (Preferences > Temporary Citations) assure curly 
braces for Citation Markers to handle the short citations.

Define the reference
data base in EndNote

You may specify the reference data base with File > Open 
before you start FM+EN or on demand of the utility.

For your work you might have a specific data base where you 
collect all references from various sources.

Specifying the
output format

You may specify the output format (e.g. Numbered or IEEE) 
before you start FM+EN or on demand of the utility.

When producing numbered output, the initial number is set to 
the value from the Program setup of FM+EN.

Output format for
references in footnotes

If you want to replace the temporary citations in the text 
(most like in footnotes) by the fully formatted references, you 
will need a special output format. See Expanding temporary 
citations on page 18 for details.
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Utility FM+EN
The utility either handles an individual FM document or all 
documents of a FM book. To handle independent FM docu-
ments (they may belong to any or no book), start FM+EN in 
the first of these documents, then in the next, etc.

You can, however insert temporary citations into an arbitrary 
number of FM documents concurrently.

Operating the utility

Right clicking on FM+EN icon in the system tray opens the 
following menu:

The left picture displays the long menu, the right picture dis-
plays the short menu (see FM+EN.ini on page 21). The author 
recommends to use the long menu providing individual steps.

Program Setup This must be done before you use “Format Citations …”. This 
step defines your environment. See Setting up the utility on 
page 11 for the details.

Check file(s) … Check the file or all files in the book for illegal character x0D. 
See more details at Checking the files on page 13.

Format Citations… The three steps of the process are run in sequence. Follow the 
instructions provided by popup-messages. See more details at 
Creating the bibliography on page 14. In single-step mode this 
menu item displays as Run ALL THREE steps in sequence.

Documentation Display the PDF with this information.

About Provides a panel with program information and a disclaimer.

Suspend Hotkeys If for any reason you need in an application the key CTRL+y 
you can suspend the key function from FM+EN and later re-
activate it.

Pause Script Instead of selecting from the menu use the PAUSE key. The 
first press of PAUSE halts the script. The program icon 
becomes . Resume the script with an additional key press.

While FM+EN is paused, you may operate other programs. 
Before you resume FM+EN you must – and this is essential – 
re-establish the state (active/inactive) of the involved win-
dows (FrameMaker, Find/Replace, Word, EndNote).

Exit Close FM+EN. You may use the BREAK key (CTRL+PAUSE) for 
this. Press it not too shortly.

If you exit FM+EN before is has finished its task close the open 
files without saving in FrameMaker and Word.
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Restrictions when 
running FM+EN

During the operation of FM+EN (except when the utility is just 
used to insert temporary citations) observe the following:

Generally Do not run your machine on battery - plug it in to mains.

Any program which automatically starts (for example, 
backup, automatic Windows Update) may change the focus 
and hence may create unpredictable results.

Do not click or type during the operation of FM+EN. This 
will change the focus (active window) and interfere with 
the simulated keystrokes.

Answer only to dialogues from FM+EN. The window title of 
these start with [FM+EN].

In FrameMaker Book names and document names must not contain a ] 
symbol. This could interfere with the detection of tile types 
by FM+EN.

Switch off automatic update of FM (Help > Updates…). You 
will need to run through an update request until you can 
switch off automatic updating in the Update Preferences!

Switch off the display of graphics in your FM document or 
for all documents in the book (View > Options). Loading 
and displaying graphics may take to much time for proper 
synchronisation of the programs involved.

Close all palettes (Tools, ¶-catalogue, f-catalogue, Equation-
palette, …)

In Word In Word switch off the Office Clipboard to avoid interfer-
ence.

Note: Of course, you can open the menu of FM+EN during its opera-
tion with a right-click and you can use the keys PAUSE and 
BREAK.
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Temporary citations 
replaced by formatted 
citations

The number of found and formatted citations include dupli-
cate items Unresolved citations count only the number of dif-
ferent citations.

Copy the generated bibliography from Word to the appropri-
ate place in FrameMaker. Use Paste Special with RTF to keep 
the formatting from EndNote. Apply your ¶ format, but be 
careful with applying character formats.

1. Bartels, K., Veni vidi vici. 5 ed. Lebendige Antike. 
1981, Zürich: Artemis Verlag. 88.

2. Daube, K. Text and Code - A Dragons Pond. in 
G.U.I.D.E. Conference. 1989. Basel, Switzerland: 
GUIDE.

EndNote is left open. You may wish to close it.

Temporary citations 
expanded to references

The number of reported citations include duplicate items.

FM+EN has done all work for you. Hence Word is already 
closed.

EndNote is left open. You may wish to close it.

Exiting FM+EN Clicking the OK button on the Finish messages terminates the 
utility and the message displayed below will pop up twice.

Selecting Exit from the menu also terminates the program. 
The following dialogue will shortly pop up once.:

Timing The processing may seem slow, but an acceleration is not pos-
sible to keep the various things in sync. There are special 
halts (few seconds) built in to provide certain functions (e.g. 
open file) enough time for completion.

On the other side, some optimisation was possible for 
version 3:

Handle all temporary citations of one FM paragraph inter-
nally.

Remove duplicates from the formatted citations before 
replacing the temporary citations in FM.



1 - 17 FM+EN 3.0

Adding bibliography incrementally
D

O
:\

[E
]\

_D
D

D
p

ro
je

ct
s\

FM
+

E
N

\D
o

cu
m

e
n

ta
ti

o
n

\f
m

+
e
n

-d
o

cu
.f

m
 

2
0

0
8

-0
9

-2
3

Adding bibliography incrementally

When extending the document after inserting the bibliogra-
phy you might need to sort in the added bibliography para-
graphs manually and also adapt any numbering.

Therefore you are recommended to keep the file(s) with tem-
porary citations and use the file(s) with the formatted refer-
ences only to create an intermediate (or final) “state of the 
work”.

Bibliography in a FrameMaker book

If FM+EN is started in a FrameMaker book, it automatically 
collects and changes the citations in all files of the book.

1 Open all files of the book and handle messages concerning 
“missing fonts”, “missing graphics” etc. accordingly.

You open all files in a book by pressing SHIFT while you 
select menu File > Open all Files in Book...

2 Close all files before you start FM+EN, although FM+EN 
will open them again! This is necessary for a clear start sit-
uation.

Note: To assure this procedure FM+EN gives you the opportunity for 
verification with the following message:

3 The document windows will be maximised to get correct 
window titles and one file after the other will be opened.

4 FM+EN continues analogous to a single file.

Note: If the last file of a book is also used at another place, then only 
the files up to this will be processed. This arrangement is not 
possible with FrameMaker menu positions – with other means 
it is possible – and I have really seen such book constructs …

Improper book structure:

preface.fm

introduction.fm

conclusion.fm same file as the last in the book

methodology.fm

these files will not be processedfindings.fm

…

conclusion.fm last file
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Expanding temporary citations

A special form of bibliography places the bibliographic refer-
ences in footnotes4). In this case, the citation in the text is 
just the footnote reference as here5). For example:

To achieve this, the following steps are required:

1 For each reference you create a footnote and insert the 
temporary citation in the footnote.

2 In the Setup of FM+EN activate the check box Expand tem-
porary citations … (see Setting up the utility on page 11).

3 In EndNote define the output format _FM+EN-expanding. 
See hereafter for the procedure.

4 Now start the processing in FM+EN.

Reference output format To convert citations into references, FM+EN expects the End-
Note output format _FM+EN-expanding (the underscore at the 
beginning of the name is essential). This must be created as 
follows:

1 Create a copy of your favourite output format and save it 
with the name _FM+EN-expanding.

2 Edit the format to get the following properties:

Citations > Templates: [Bibliography Number]

(The brackets are essential)

Bibliography > Layout: Bibliography Number.8
(8 is the TAB-field. Do not 
forget the period) 

3 Save the modified output format _FM+EN-expanding.

4 They may, however, also appear in the text or as side notes.
5 See also Expanded citations, second method on page 1-19

Before processing Hecate est Iovis et Latonae filia, soror Apollinis 1). Est 
tricopor et triceps, magicarum artium magistra ac 
fascinationum praeses, cinctra latrantium canum turma 2); 
noctu stans in triviis vel prope sepulcra et ubi loca sunt.

1 [[LaBonté, 1989 #11]]
2 [[Garneau, 1990 #12]]

After processing Hecate est Iovis et Latonae filia, soror Apollinis 1). Est 
tricopor et triceps, magicarum artium magistra ac 
fascinationum praeses, cinctra latrantium canum turma 2); 
noctu stans in triviis vel prope sepulcra et ubi loca sunt.

1 LaBonté, A. A New Data Type for National Language? in SEAS Anniver-
sary Meeting. 1989. Amsterdam, The Netherlands: SHARE European As-
sociation.

2 Garneau, D., ed. National Language Support Reference Manual. January 
10, 1990 ed. National language Information Design Guide, ed. IBM. Vol. 
2. 1990, IBM National Language Technical Centre: Toronto, CDN.
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Successive similar 
references

You may have the same reference on one page in succession. 
Before You start FM+EN you should replace the second to last 
same reference by the word ibid6):

Then this reference will not be resolved by the process - as it 
is just ordinary text:

Final work Since Footnotes in FrameMaker may end up on the following 
page of their reference, the ibid may be placed wrongly. 
Hence you need to check this and probably replace some ibid 
by the original citations, which you will find in the footnote 
before the one with the ibid.

Expanded citations, second method

If you know right from the beginning that this is the format of 
choice, you may use a simple copy and paste from EndNote. 
The format of the references must be set in EndNote output 
format drop down list. 

Since the footnotes themselves are numbered you should use 
an output format not containing numbering, such as (in the 
examples here) Academic Management Review. 

For best appearance you may need to set up an own output 
format which fits to your FM document appearance (see Refer-
ence output format on page 1-18)

To insert the bibliographic reference:

1 Place a footnote reference in your text like this 7).

2 In EndNote find the desired bibliographic reference.

3 With CTRL+k copy the reference to the clipboard.

4 In the footnote (see bottom of page) paste the text from the 
clipboard. 

Note: Depending on your settings in maker.ini for 
ClipboardFormatsPriorities you will either use ordinary 
paste (CTRL+v) or paste special (with RTF) by SHIFT+CTRL+v 
get the formatted text or the unformatted text as with this foot-
note8).

6 The word ibid stands for ibidem (aforementioned)
7 Müller, P. D. H. 1925. De viris illustribus (9 ed.). Hannover: 

Carl Meyer (Gustav Prior).
8 Müller, P. D. H. 1925. De viris illustribus (9 ed.). Hannover: Carl Meyer 

(Gustav Prior).
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Background information
FrameMaker 8 fully supports a subset of Unicode and hence 
supports nearly any language with left-to-right script. The 
correct glyphs are only visible if an appropriate font is used 
for the text9).

Searching for temporary citations

Due to the very limited ‘wildcard search’ in FrameMaker, 
which is not sufficient to search for real patterns (as with 
Regular Expressions), FM+EN up to version 2.5 could only 
find and process a limited number of citation formats.

Starting with FM+EN v3.0 a new method is used which does 
not impose any restriction to the contents of the citations:

If a ‘start citation’ sequence ([[) is found, the text of the cur-
rent paragraph is processed inside of FM+EN to find the cita-
tion(s). See Mixing citations in text and in footnotes on page 7 for 
consequences of this method.

EndNote and FrameMaker

Starting with EndNote version 8 the database used Unicode. I 
have not tested FM+EN 3.0 with older EndNote versions.

Over the time the various EndNote releases have changed 
their behaviour, in particular with relation to FrameMaker:

Only EndNote versions 1 … 5 provide the function Scan Doc-
ument in mif. Version 6 does not support any scan and start-
ing with version 7 scanning RTF is back.

Installation

FM+EN is provided in a ZIP archive which you expand into any 
directory of your liking. The expanded data structure con-
tains a sub directory TestFiles with appropriate content.

You may wish to create a shortcut on your desktop to the pro-
gram (fm+en.exe).

9 If your bibliographic references only use ‘western’ languages, nearly any 
TrueType or OpenType font is OK.

EndNote 
Version

Cooperation

Handling none-Word files Word FM

5 (2001-09) Scans MIF and RTF, handles non-ASCI characters 
not correctly

+++ ++

6 (2002-06) No scan of RTF or MIF possible – purely a Word 
thing

+++ 0

7 (2003) Scan of RTF possible, but not MIF +++ +

8 (2004) New data base format to support UNICODE; only 
working with Word, No MIF support

++++ +

9 (2005) Same as for EN 8 ++++ +

X (2006) Slight difference in menu names to EN 8 ++++ +
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FM+EN.ini

The file fm+en.ini keeps information needed to run the 
processing steps individually. Also some information to influ-
ence the behaviour of the utility is kept here.

Please edit this file only on request of the author or with suffi-
cient knowledge of the effects.

Content of FM+EN.ini
(example)

[FM+EN]
; For version number see menu About
; Manually change this file only on advice of D+DD
; ----------------------- template
rtfTemplate   = FM+EN.doc
; ----------------------- temporary storage
rtfSave       = fm-biblio.rtf
formattedFile = fm-biblio-IEEE.rtf
expandCits    =0
bookActive    =0
numRefs       =11
shortMenu     =0
time1         =69.953000
time2         =14.172000
time3         =88.734000
; ----------------------- versions of involved programs
fmVersion     =8
fmLanguage    =en
enVersion     =9
enLanguage    =en
enNumStart    =1
wdLanguage    =en
winLanguage   =en
; ----------------------- sound on/off
noBeeps       =1
sound         =7.994202
; ----------------------- timing values for 3Mhz machine
keyDelay      =0
; keydelaytime for keyDelay=1
delayTime     = 150
sleepTime     = 300
; sleepTimeLong = 4*sleepTime
x0dTime       =10
; ----------------------- debugging
debugging     = 

Explanation FM+EN.doc Template for collecting the citations. If this 
file has been destroyed, it may be copied 
from FM+EN.saved.doc

expandCits =1 if citations are to be expanded

bookActive =1 if work starts in an FM book

shortMenu =1 hides the individual steps in the menu.
=0 reveals all steps in the menu

x0dtime Time for one file in a book to check for ille-
gal characters

Why an external program FM+EN is a program external to FrameMaker and not a plug-
in, because a script would need the script interpreter and I do 
not have the capacity to program plug-ins which require C.
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Help – it does not work!
It is quite difficult to time a program from the outside. Hence 
it may occur that FM+EN does not behave. Some of these 
problems disappear with a restart of the utility, some call for 
more investigation.

Essential preconditions Do not forget to check all the constraints listed in Restrictions 
when running FM+EN on page 10. Not observing these will cre-
ate problems.

Run process steps 
individually

To ease problem handling the process steps can be run indi-
vidually. Set shortMenu =0 in the FM+EN.ini file for this pur-
pose (see FM+EN.ini on page 21).

Running the same process step repeatedly requires that you 
re-establish the mandatory initial state:

For step 1 (collecting
citations)

Revert to Saved all the involved FrameMaker files. Be aware 
that their opening must not create any errors such as Font not 
found. Switch off graphics display for all files.

Close Word without saving anything.

For step 2 (formatting
citations in EndNote)

EndNote must be started and the proper library be open. Also 
the desired output format must be selected.

Word need not to be started, but can be (no document open).

For step 3 (replace
temp. citations in FM)

The FM file or all book files must be open. In case of a book 
the active window must be the maximised book window. At the 
end of this step the files are not saved by FM+EN. If some-
thing went wrong, you may close them without saving.

It would be good practice to save the modified FM documents 
(including the book file) in a new directory. See Adding bibliog-
raphy incrementally on page 17

Word need not to be started for step 3, but can be (with no 
document open). At the end of this step, do not save the 
altered Word document to be able to repeat this process step.

Slow down processing In case of more problems it may help to run the utility slowly 
by activating the check box Work slowly in the Program 
setup.

Known issues

FM menues pop up in 
first step

In rare cases it happens that keystrokes sent to FrameMaker 
are not received correctly (for example CTRL is spilled). Some-
thing will be typed or a menu item may pop up

Note: Although most functions are now initated with alternative key-
stroke sequences, the problem may reappear.

Restart the process Stop the utility (see Exit on page 9) and close all open FM files 
without saving. Then start FM+EN again.

First line in Word file 
does not contain a 
temporary citation

Especially at the first start of FM+EN (after a Windows start) 
Windows may provide surprises: The Word file with the col-
lected temporary citations does not build up as expected.
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Note: With the new method of collecting the citations and pasting 
them all at once to Word this error should have disappeared.

Word file OK As previously displayed, the file should present a regular pat-
tern of brackets, tabs and braces:

Word file not OK If the first lines are mangled up or do not start with double 
brackets, such as the following, stop the process and start 
again.

Restart the process To ease your work you may wish to use the long menu to start 
each process step individually. In case of problems you 
should restart the whole utility, even to perform step 2 or 3. 
Necessary data of a previous step is stored in fm+en.ini.

1 Cancel the process by pressing CTRL+BREAK not to shortly

1 Close the Word file without saving

2 Revert your FM document(s) to the last saved state

3 Start FM+EN again.

FM+EN stops after the 
first process step

For the second step EndNote comes into play.

If nothing happens after the first step, you have forgotten to 
open EndNote and open a database file or the version of End-
Note defined in the Program Setup is wrong.

1 Select Exit in the menu of the utility to cancel it.

2 Close the current FM document(s) without saving it/them.

3 Assure that all other files of the FM book are also closed (if 
working from a book file)

4 Restart the Utility and set it up correctly as well as End-
Note.

[[Šèšíüš, 1999 #26]] {Šèšíüš, 1999 #26}

[[DuçanÌsídõrâ, 2006 #24]] {DuçanÌsídõrâ, 2006 #24}

[[Müller, 1925 #13]] {Müller, 1925 #13}

[[Fridriksson, 2005 #31]] {Fridriksson, 2005 #31}

bp{Müller, 1925 #13} {Müller, 1925 #13}

[[Šèšíüš, 1999 #26]] {Šèšíüš, 1999 #26}

[[DuçanÌsídõrâ, 2006 #24]] {DuçanÌsídõrâ, 2006 #24}

[[Fridriksson, 2005 #31]] [[Šèšíüš, 1999 #26]]

V

[[Müller, 1925 #13]] {Müller, 1925 #13}

{Šèšíüš, 1999 #26} [[DuçanÌsídõrâ, 2006 #24]]

[[Müller, 1925 #13]] {Müller, 1925 #13}

[[Fridriksson, 2005 #31]] {Fridriksson, 2005 #31}

[1] [1] 

[[Müller, 1925 #13]][1]
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Secondary monitor The stop may also happen, if you have EndNote running on a 
secondary monitor (with or without the other programs run-
ning also on the secondary monitor):

1 Select Exit in the menu of the utility to cancel it.

2 Close the current FM document without saving it

3 Assure that all other files of the FM book are also closed (if 
working from a book file)

4 Close EndNote and start it on the primary monitor.

5 Restart the process

FM Tools Palette pops up 
after second step

On certain machines (with German FM, Word and Windows) I 
have noticed this:

The Tools palette pops up.

The Find/Replace dialogue is not set up correctly.

Citations are not replaced but deleted.

The reason may be the same as for FM menues pop up in first 
step on page 22.

To save your time you may wish to work with individual proc-
ess steps (see Run process steps individually on page 22).

Generating footnote 
references does not work 
correctly

For this process EndNote must use the output format _FM+EN-
footnotes. This format will be selected by FM+EN. The selec-
tion will fail, if a format with a name starting with an under-
score (_) appears before the entry _FM+EN-footnotes.

Note: At least until version X (=10) EndNote does not use output for-
mat names starting with an _. So this error should not happen.

Nevertheless, Murphy’s law may strike. In this case do:

1 Inactivate these formats with Edit > Output Styles > Open 
Style Manager … (remove the tic mark in the check box). 
Of course the format _FM+EN-footnotes must be kept 
active!

2 The irritating format(s) will no longer appear in the list of 
Edit > Output Styles.

3 Select Exit in the menu of FM+EN to cancel it.

4 Close the current FM document without saving it

5 Assure that all other files of the FM book are also closed (if 
working from a book file)

6 Restart the process

Switch debugging mode 
on

To get information about errors or states of the program, at 
some points in the program messages can be issued.

Do this only on request. The program author may inform you 
to type something into the last field of the set-up dialogue of 
the utility (see Setting up the utility on page 11).

In this mode the user must react to the issued messages to 
continue operation of the utility.
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Error messages

Messages from FM+EN

No FM-book found 
anymore

If the book window is not maximised, the main window does 
not display the required window title.

Setting up EndNote FM+EN needs the output format _FM+EN-Footnotes to convert 
temporary citations in FM footnotes to references. See Refer-
ence output format on page 18 on how to set up this format.

Keyboard needs a reset For proper function the utility needs a plain keyboard state 
which is checked at the beginning. If the state is not plain a 
message indicate the necessary reset.

The found state of the left ALT, right ALT, the CTRL and the 
SHIFT key are indicated either by a U (up, OK) or D (down, not 
OK). In the picture the left ALT and the SHIFT key are ‘down’:

Keyboard in unfriendly 
state

FM+EN tried to set the keyboard into its basic state10), but 
still some modifier keys are in Down state. Follow the instruc-
tions of the message. In rare cases it will be necessary to 
reboot the system:

10 You may have cancelled the program amidst a Send-Key operation. This 
may include the sending of ALT etc.
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Superfluous brackets 
found in citation

This message appears if inside a citation the start of another 
one is found:

However, the cause normally is a missing closure of a previ-
ous citation (see arrows). Since FM+EN terminates after the 
first of these errors, the second case in the above image will 
not be found at the same run.

To be able to find the location of this error in your document, 
FM+EN creates a temporary FrameMaker document contain-
ing the same text as the processed document, but with the 
indicator !!??!! placed at the beginning of the found citation:

According to the surrounding text you can find the corre-
sponding location in your document and correct the text.

Note: Close the generated Word file without saving before you 
restart the process!

Messages from EndNote

File is not RTF The filename to be scanned is written into an Open dialogue. 
In rare cases the file name is distorted (for example, charac-
ters lost) as in this example: 

In this case EndNote stops with this error message:

1 Select Exit in the menu of the utility to cancel it.

2 Close the current FM document without saving it

3 Assure that all other files of the FM book are also closed (if 
working from a book file)

4 Restart the process
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Service Error After scanning the RTF file for citations, this file will be for-
matted and saved with a new name according to the selected 
output format.

EndNote may not be able to save the generated RTF file and 
issues a “Service Error” message. FM+EN gets notice of this 
situation and issues the message: 

In my case nothing11) but a program update (9.0 8 9.0.1) 
cured the problem.

11 http://www.adeptscience.co.uk/kb/article/C86E or 
http://www.endnote.com/support/faqs/Install/faq1.asp
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